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Introduction  
More and more people today face the problem of smooth and cost saving system migration. It mostly has to do with 

constant hardware improvement. Traditional approach involving complete re-installation and re-setup of the operating 

system and all applications requires a lot of time anŘ ƭŀōƻǊ ǊŜǎƻǳǊŎŜǎΣ ŦŜǿ Ŏŀƴ ŀŦŦƻǊŘΦ aƻǊŜƻǾŜǊ ƛǘ ŘƻŜǎƴΩǘ ƎǳŀǊŀƴǘŜŜ ŀƭƭ 

software will flawlessly work on a new hardware platform. 

tŀǊŀƎƻƴ ±ƛǊǘǳŀƭƛȊŀǘƛƻƴ aŀƴŀƎŜǊϰ 2010 is an elegant solution that can help you accomplish the following tasks: 

¶ Migrate a live Win2K+ physical system to a virtual environment (P2V Copy); 

¶ Restore a Win2K+ physical system ŦǊƻƳ ŀ tŀǊŀƎƻƴΩǎ ōŀŎƪǳǇ to a virtual environment (P2V Restore); 

¶ Migrate a Win2K+ virtual system to a physical environment (V2P); 

¶ Migrate from one virtual environment to another (V2V); 

¶ Migrate a Win2K+ physical system to a different hardware platform (P2P); 

¶ /ƻƴƴŜŎǘ ŀ ǾƛǊǘǳŀƭ Řƛǎƪ ŀǎ ƛŦ ƛǘΩǎ ŀƴ ƻǊŘƛƴŀǊȅ ǇƘȅǎƛŎŀƭ ŘƛǎƪΣ ǘƘǳǎ ƻǇŜƴƛƴƎ ǳǇ ŀƭƭ ŦǳƴŎǘƛƻƴŀƭƛǘȅ ŀǾŀƛƭŀōƭŜ ŦƻǊ ǇƘȅǎƛŎŀƭ 

disks to virtual (Connect VD); 

¶ Make OS start up after unsuccessful migration with 3rd party tools (P2V Adjust OS/P2P Adjust OS). 

In this manual you will find the answers to many of the technical questions, which might arise while using the program. 

 

Our company is constantly releasing new versions and updates to its software, that's why 

images shown in this manual may be different from what you see on your screen. 

7ÈÁÔȭÓ .Å× ÉÎ 6ÉÒÔÕÁÌÉÚÁÔÉÏÎ -ÁÎÁÇÅÒȩ 
¶ The updated P2V Copy/ Restore Wizards ǘƻ ƳƛƎǊŀǘŜ ŀ ²ƛƴнYҌ ǇƘȅǎƛŎŀƭ ǎȅǎǘŜƳ όƭƛǾŜ ƻǊ ŦǊƻƳ ŀ tŀǊŀƎƻƴΩǎ ōŀŎƪǳǇύ 

to a virtual environment of one of the supported virtualization software vendors. In the latest version of the 

product the wizards enable to: 

- Create and properly configure virtual machines according to your preferences. Depending on the selected 

ǾƛǊǘǳŀƭƛȊŀǘƛƻƴ ǾŜƴŘƻǊ ȅƻǳΩǾŜ Ǝƻǘ ǘƘŜ ƻǇǘƛƻƴ ǘƻ ǎǇŜŎƛŦȅ ŀ ǾŜǊǎƛƻƴ ƻŦ ǘƘŜ ŦǳǘǳǊŜ ǾƛǊǘǳŀƭ ƳŀŎƘƛƴŜ, its name, 

location, RAM to allocate, a disk controller, the guest OSΣ ŜǘŎΦ {ƻ ǿƘŜƴ ǘƘŜ ƳƛƎǊŀǘƛƻƴ ƛǎ ƻǾŜǊΣ ȅƻǳΩƭƭ ƎŜǘ ƴƻǘ 

only a virtual disk that contains an operating system and/or data, but a ready-to-use virtual machine. 

- Convert any combination of hard disks and partitions to migrate your entire computer or certain partitions 

in one operation. Complex backups that contain partitions from different hard disks are supported as well. 

- Employ MS VSS (Volume Shadow Copy Service) to synchronously migrate from several hard disks, thus 

ensuring data consistency during online migration of a system, which seats on several partitions or hard 

disks. This is achieved by taking a point-in-time snapshot of the whole disk subsystem. 

- When migrating from several hard diskǎΣ ŀƭƭ ǘƘŜƛǊ ǎƛƎƴŀǘǳǊŜǎ ǿƛƭƭ ōŜ ƪŜǇǘ ƛƴǘŀŎǘΣ ǎƻ ȅƻǳΩƭƭ ƎŜǘ ǘƘŜ ǎŀƳŜ ŘǊƛǾŜ 

letters in a virtual environment. 
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¶ The updated P2V Adjust OS Wizard allows creation of virtual machines as well, so besides its primary function, 

you can now build virtual machines out of supported virtual disks or Windows Vista/7 backup images. 

¶ The updated Connect VD ǘƻ ŎƻƴƴŜŎǘ ŀ ǾƛǊǘǳŀƭ Řƛǎƪ ŀǎ ƛŦ ƛǘΩǎ ŀƴ ƻǊŘƛƴŀǊȅ ǇƘȅǎƛŎŀƭ ŘƛǎƪΣ ǘƘǳǎ ƻǇŜƴƛƴƎ up all 

ŦǳƴŎǘƛƻƴŀƭƛǘȅ ŀǾŀƛƭŀōƭŜ ŦƻǊ ǇƘȅǎƛŎŀƭ Řƛǎƪǎ ǘƻ ǾƛǊǘǳŀƭΦ ¸ƻǳΩǾŜ ƴƻǿ Ǝƻǘ ǘƘŜ ƻǇǘƛƻƴ ǘƻΥ 

- Mount a virtual disk in the read-only mode to make sure no data will be changed on the virtual disk during 

copy or any other operation on it. 

- Support for VMware ESX ServerΩǎ export format to copy/retrieve data from virtual machines of this vendor. 

LǘΩǎ ǳǎŜŦǳƭ ŦƻǊ ƻŦŦƭƛƴŜ ±н± ŀƴŘ ±нt ƻǇŜǊŀǘƛƻƴǎΦ 

¶ Create VD Wizard to create an empty virtual disk or with specific data of one of the supported virtualization 

vendors. 

¶ The updated P2P Adjust OS Wizard to successfully start up a Win2K+ physical system on a different hardware 

platform (P2P) by allowing injection of all required drivers and the other actions crucial for this type of 

ƳƛƎǊŀǘƛƻƴΦ LƴŎƭǳŘƛƴƎ ǘƘŜ ǘƘƛǊŘ ƎŜƴŜǊŀǘƛƻƴ ƻŦ tŀǊŀƎƻƴΩǎ !ŘŀǇǘƛǾŜ wŜǎǘƻǊŜϰ ǘŜŎƘƴƻƭƻƎȅΣ ƛǘ ƴƻǿ ŎŀƴΥ 

- Analyze all installed drivers inside a target system to report on devices without drivers. 

- Search for and install lacking drivers from the built-in Windows repository. 

- Notify the user about boot critical devices without drivers (HDD/RAID controllers, etc.), automatically 

prompting to provide a path to a driver repository. 

- Name all devices according to their model description, not some alphanumeric code, which requires 

additional deciphering. 

- Determine and install drivers not only for boot critical devices, but for physically connected NICs as well. 

¶ WinPE 3.0 based bootable environment to enjoy support of a wider range of hardware configurations with the 

option to add drivers for specific hardware on-the-fly. 

¶ The updated Boot Corrector for WinPE that now equals the functionality of the Linux/DOS counterpart. 
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Product Components  
tŀǊŀƎƻƴ ±ƛǊǘǳŀƭƛȊŀǘƛƻƴ aŀƴŀƎŜǊϰ нлмл Ŏƻƴǘŀƛƴǎ ǎŜǾŜǊŀƭ ŎƻƳǇƻƴŜƴǘǎΥ 

¶ Windows based utilities. With the help of an easy to use launcher you may find and run the required task, open 

the help system, or collect log files for Paragon Support Team. 

¶ WinPE based environment. Our product also includes a WinPE 3.0 bootable environment, which you can build 

on CD/DVD or a thumb drive. It offers excellent hardware support and the same interface and functionality as 

ǘƘŜ ²ƛƴŘƻǿǎ ǾŜǊǎƛƻƴ ŘƻŜǎΦ 5ŜǎǇƛǘŜ ǘƘŜ ŦŀŎǘ ǘƘŀǘ ƛǘǎ ǎȅǎǘŜƳ ǊŜǉǳƛǊŜƳŜƴǘǎ ŀǊŜ ǘƻǳƎƘŜǊΣ ƛǘΩǎ ǇǊŀŎǘƛŎŀƭƭȅ 

indispensible for V2P and P2P scenarios. 

Features Overview  
This chapter dwells upon key benefits and technical highlights of the product. 

Key Features  
Let us list some of the key features: 

¶ P2V Copy to migrate a live Win2K+ physical system to a virtual environment. 

¶ P2V Restore to restore a Win2K+ physical system from a ParagonΩǎ backup directly to a virtual environment. 

¶ Connect VD ǘƻ ŎƻƴƴŜŎǘ ŀ ǾƛǊǘǳŀƭ Řƛǎƪ ŀǎ ƛŦ ƛǘΩǎ ŀƴ ƻǊŘƛƴŀǊȅ ǇƘȅǎƛŎŀƭ ŘƛǎƪΣ ǘƘǳǎ ƻǇŜƴƛƴƎ ǳǇ ŀƭƭ ŦǳƴŎǘƛƻƴŀƭƛǘȅ ŀǾŀƛƭŀble 

for physical disks to virtual. 

¶ P2V Adjust OS to recover the startup ability after unsuccessful virtualization with a 3rd party tool; to make 

Windows Vista/7 backups bootable on virtual hardware. 

¶ P2P Adjust OS to migrate a Win2K+ physical system to a different hardware platform; to recover the startup 

ability after unsuccessful migration with a 3rd party tool. 

¶ Create VD to create an empty virtual disk or with specific data of one of the supported virtualization vendors. 

¶ Support for major virtual machines, Microsoft Virtual PC, Microsoft Virtual Server, Microsoft Hyper-V, VMware 

Workstation, VMware Fusion, VMware ESX Server, Oracle VirtualBox. 

¶ Smart Driver Injector to make the process of adding new drivers smooth and easy. 

¶ Easy size setup for virtual disks with the partition auto-resize option. 

¶ Disk file split for VMware to automatically cut the resulted virtual image to files of 2 GBs each. 

¶ Partition/Hard disk copy to successfully transfer all on-disk information including standard bootstrap code and 

other system service structures, thus ƳŀƛƴǘŀƛƴƛƴƎ ǘƘŜ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳΩǎ ǿƻǊƪƛƴƎ ŎŀǇŀōƛƭƛǘȅΦ 

¶ File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD 

as easy and convenient as possible. 

¶ Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent partitions 

(NTFS, FAT16/FAT32), into a single, larger partition. 
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¶ Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk unallocated 

space and the unused space of other partitions. 

¶ Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting. 

¶ Modify file system parameters (make active/inactive, hide/unhide, change serial number, partition ID, volume 

label, etc.). 

¶ Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the 

standard Windows disk tools, the program supports all popular file systems. 

¶ Undelete Partitions Wizard to recover an accidentally deleted partition. 

¶ 27 defragmentation strategies available to defragment FAT and NTFS file systems. 

¶ MFT defragmentation and shrinking to improve performance of NTFS. 

Supported Technologies  
Along with using innovative technologies from outside, Paragon has developed a number of its own original 

technologies that make its products unique and attractive for customers: 

¶ tŀǊŀƎƻƴ Iƻǘ /ƻǇȅϰ technology to clone locked partitions and hard disks under Windows NT+ family operating 

systems providing both high operating efficiency as well as low hardware requirements. 

¶ tŀǊŀƎƻƴ !ŘŀǇǘƛǾŜ wŜǎǘƻǊŜϰ technology to successfully migrate a Win2K+ physical system to a different 

hardware platform (P2P). 

¶ tŀǊŀƎƻƴ tƻǿŜǊ {ƘƛŜƭŘϰ technology to provide data consistency in case of a hardware malfunction, power 

outages or an operating system failure. 

¶ tŀǊŀƎƻƴ ¦C{5ϰ technology to browse partitions of any file system including hidden and unmounted, modify 

and copy files and folders, etc. 

¶ tŀǊŀƎƻƴ Iƻǘ wŜǎƛȊŜϰ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and 

interrupting its work. 

¶ tŀǊŀƎƻƴ {ƳŀǊǘ tŀǊǘƛǘƛƻƴϰ technology to securely perform hard disk partitioning operations of any complexity. 

¶ tŀǊŀƎƻƴ ±Laϰ (Virtual Image Management) technology that enables Paragon products work with virtual disks 

as if they are physical hard disks. 

¶ Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft 

Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent 

point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the 

leading copy/backup solution vendors on the market, it is based on a snapshot technology concept. 

¶ Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility 

without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale 

businesses when dealing with many physical hard disks involving complex setup. 

¶ GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift 

restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux. 
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Supported Virtual Machines  
Paragon Virtualization ManŀƎŜǊϰ 2010 provides support for major virtual machines presented on the market today: 

¶ Microsoft Virtual PC; 

¶ VMware Workstation; 

¶ VMware Fusion; 

¶ Oracle VirtualBox; 

Additionally for Connect VD and P2V Adjust OS only 

¶ MS Windows Vista/7 backup; 

Additionally for Connect VD only 

¶ Parallels Workstation; 

¶ XenServer (.vhd only). 
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Getting Started  
In this chapter you will find all the information necessary to get the product ready to use. 

System Requirements  

Windows based utilities  

To use the Windows utilities, you should install them first. But before that, make sure your computer meets the 

following minimum system requirements: 

¶ Operating systems: Windows 2000 Professional and later, except server editions 

¶ Internet Explorer 5.0 or higher  

¶ Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

¶ 128 MB of RAM (256+ recommended) 

¶ Hard disk drive with 100 MB of available space  

¶ SVGA video adapter and monitor  

¶ Mouse 

WinPE environment  

To use the WinPE based utilitƛŜǎ ƻƴ ȅƻǳǊ ŎƻƳǇǳǘŜǊΣ όƛǘ ŘƻŜǎƴΩǘ ƳŀǘǘŜǊ ǿƘŀǘ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳ ƛǎ ƛƴǎǘŀƭƭŜŘύΣ ƳŀƪŜ ǎǳǊŜ 

that it meets the following minimum system requirements: 

¶ Intel Pentium III CPU or its equivalent, with  1000 MHz processor clock speed 

¶ At least 512 MB of RAM 

¶ SVGA video adapter and monitor 

¶ Mouse 

Additional requirements  

There may be additional requirements if you want to use advanced features: 

¶ Network card to send/retrieve data to/from a network computer 

¶ Recordable CD/DVD drive to burn data to compact discs 

¶ External USB hard drive to store data. 

Installation  
The setup utility has the standard user interface and set of installation steps. Once the installation procedure is 

completed you need to restart the system to activate a system driver that will enable to copy locked partitions/hard 

disks online. 

First Start  
To start Paragon Virtualization Manager 2010 under Windows, please click the Windows Start button and then select 

tǊƻƎǊŀƳǎ Ҕ tŀǊŀƎƻƴ ±ƛǊǘǳŀƭƛȊŀǘƛƻƴ aŀƴŀƎŜǊϰ нлмл Ҕ tŀǊŀƎƻƴ ±ƛǊǘǳŀƭƛȊŀǘƛƻƴ aŀƴŀƎŜǊϰ. 
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The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization 

and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular 

basis. With its help you can also staǊǘ ǳǇ ǘƘŜ ǘǊŀŘƛǘƛƻƴŀƭ ƭŀǳƴŎƘŜǊΣ ǘƘŜ ƘŜƭǇ ǎȅǎǘŜƳ ƻǊ Ǝƻ ǘƻ ǘƘŜ ǇǊƻƎǊŀƳΩǎ ƘƻƳŜ ǇŀƎŜΦ 

 

 

To start up the traditional Launcher, please click on Switch to Full Scale Launcher. 

¢ƻ ƪƴƻǿ ƳƻǊŜ ƻƴ Ƙƻǿ ǘƻ ƘŀƴŘƭŜ ǘƘŜ ǇǊƻŘǳŎǘΩǎ ƛƴǘŜǊŦŀŎŜ ŀƴŘ ŀŎŎƻƳǇƭƛǎƘ ǘȅǇƛŎŀƭ ƻǇŜǊŀǘƛƻƴǎΣ 

please consult the Windows Components chapter. 

Booting from the WinP E Environment  
1. Start up the computer from our WinPE environment, which you can prepare on a CD/DVD disc or a thumb drive. 

Please make sure the on-board BIOS is set up to boot from CD/USB first. 

2. Read tŀǊŀƎƻƴΩǎ ƭƛŎŜƴǎŜ agreement and then mark the appropriate checkbox to accept. If you do not agree with 

ŀƴȅ ŎƻƴŘƛǘƛƻƴǎ ǎǘŀǘŜŘ ǘƘŜǊŜΣ ȅƻǳ ǿƻƴΩǘ ōŜ ŀōƭŜ ǘƻ ǳǎŜ ǘƘŜ ǇǊƻƎǊŀƳΦ 
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3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run 

components of the product, load drivers for undefined hardware or establish a network connection. 

 

4. Click on the required operation to start. Hints will help you make the right choice. 

 
Our WinPE 3.0 based environment offers excellent hardware support. However in case it 

doesƴΩǘ ƘŀǾŜ ŀ ŘǊƛǾŜǊ ŦƻǊ ȅƻǳǊ Řƛǎƪ ŎƻƴǘǊƻƭƭŜǊΣ ȅƻǳǊ ƘŀǊŘ Řƛǎƪǎ ǿƛƭƭ ōŜ ǳƴŀǾŀƛƭŀōƭŜΦ tƭŜŀǎŜ 



13 

/ƻǇȅǊƛƎƘǘϭ мффп-2010 Paragon Software Group. All rights reserved. 

consult the Adding specific drivers scenario to know how to tackle this issue. 

Contacting Paragon Technology GmbH  
If you have any questions about the company products, please do not hesitate to contact Paragon Technology GmbH. 

Service Contact 

Visit Paragon GmbH web site www.paragon-software.com 

Registration & updates web-service www.paragon-software.com/support 

Knowledge Base & Technical Support kb.paragon-software.com 

Pre-sale information sales@paragon-software.com 

 

http://www.paragon-software.com/
https://www.paragon-software.com/support/index.html
http://kb.paragon-software.com/
mailto:sales@paragon-software.com
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Basic Concepts  
This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general 

notion of the operation performance and makes it easier for the user to operate the program. 

About System Virtualization  
With new powerful x86 computers, system virtualization has become extremely popularΦ LǘΩǎ ŀ ǎƻŦǘǿŀǊŜ ǘŜŎƘƴƻƭƻƎȅ ǘƘŀǘ 

enables to run several virtual machines on one physical machine, providing resources of that single computer are shared 

across several environments. As a result one and the same physical computer can have multiple OSs and applications 

operating simultaneously, thus opening up enormous opportunities for both, business and home users, exactly: 

¶ Avoid underutilization of up-to-date powerful computers; 

¶ Increase flexibility of a physical infrastructure; 

¶ Provide for increased availability of hardware and applications; 

¶ Cut expenses on hardware and energy; 

¶ Guarantee smooth and cost saving system migration; 

¶ 9ƴƧƻȅ ǿƻǊƪƛƴƎ ǿƛǘƘ ƻƭŘ ŀǇǇƭƛŎŀǘƛƻƴǎ ȅƻǳ ŎŀƴΩǘ ƭŀǳƴŎƘ ƻƴ ȅƻǳǊ ŎǳǊǊŜƴǘ t/Τ 

¶ Take advantage of having multiple operating systems on one Windows PC, including Linux, Mac OS X, etc.; 

¶ Forget about hunting for replacement of the failed hardware, anŘ Ƴŀƴȅ ƳƻǊŜΧ 

Known Issues 

1. You should install integration services of your particular version of virtualization software (e.g. VMware Tools) 

on the virtual system yourself. We only guarantee its smooth startup. 

2. After transferring Microsoft Vista and later versions to a virtual environment, you will need to re-activate license 

ƻŦ ǘƘŜ ǎȅǎǘŜƳΦ LǘΩǎ ƴƻǊƳŀƭ ōŜƘŀǾƛƻǊ ŀǎ ǘƘŜǎŜ ǎȅǎǘŜƳǎ ƪŜŜǇ ǘǊŀŎƪƛƴƎ ŀƴȅ ŎƘŀƴƎŜ ƻŦ ƘŀǊŘǿŀǊŜΦ wŜ-activation is 

legally justified in this case. 

3. If your system hosts several Windows OSes, our program will find them all and automatically patch to run in a 

virtual environment. However we cannot guarantee smooth startup of all found Windows systems, but the 

guest OS, for its configuration parameters may be incompatible with the others. 

About Adaptive Restore Technology  

Technology Background 

Windows family operating systems are notorious for their excessive sensibility to hardware, especially when it turns to 

replacement of such a crucial device as HDD controller or motherboard ς actually Windows will most likely fail to boot 

as a result of this operation. 

Lƴ нллу ƻǳǊ ŎƻƳǇŀƴȅ ŎŀƳŜ ǿƛǘƘ ŀƴ ŜȄŎƭǳǎƛǾŜ ǘŜŎƘƴƻƭƻƎȅ ŎŀƭƭŜŘ tŀǊŀƎƻƴ !ŘŀǇǘƛǾŜ wŜǎǘƻǊŜϰΦ Lƴƛǘƛŀƭƭȅ ŀƛƳŜŘ ŀǘ ǊŜǎǘƻǊŜ ƻŦ 

Windows Vista or Server 2008 from a backup to a different hardware configuration, its current realization, available in 

the P2P Adjust OS Wizard, enables to make any Win2K system (Windows 2000/XP/Server 2003 and Vista/7/Server 2008) 

bootable on dissimilar hardware by allowing automatic injection of all required drivers and the other actions crucial for 

this type of migration. 



15 

/ƻǇȅǊƛƎƘǘϭ мффп-2010 Paragon Software Group. All rights reserved. 

Technology Concept 

[ŜǘΩǎ ǘŀƪŜ ŀ ŎƭƻǎŜǊ ƭƻƻƪ ŀǘ Ƙƻǿ tŀǊŀƎƻƴ !ŘŀǇǘƛǾŜ wŜǎǘƻǊŜ ǿƻǊƪǎΦ 

 

As you see, successful migration of a Win2K system to a different hardware platform involves several actions: 

1. Change of the Windows kernel settings according to the new configuration. The program detects the given 

hardware profile and automatically installs the appropriate Windows HAL and kernel. 

2. Installation of drivers for boot critical devices. The program detects those without drivers and automatically 

tries to install lacking drivers from the built-ƛƴ ²ƛƴŘƻǿǎ ǊŜǇƻǎƛǘƻǊȅΦ LŦ ǘƘŜǊŜΩǎ ƴƻ ŘǊƛǾŜǊ ƛƴ ǘƘŜ ǊŜǇƻǎƛǘƻǊȅΣ ƛǘ 

prompts the user to set a path to an additional driver repository, strongly recommending not to proceed until all 

drivers for the found boot critical devices are installed. In case drivers for these devices are installed, but 

disabled, they will be enabled. 

3. Installation of drivers for a PS/2 mouse and keyboard. This action will only be accomplished for Windows 

2000/XP/Server 2003. 

4. Installation of drivers for network cards. The program detects those without drivers and automatically tries to 

install lacking drivers from the built-ƛƴ ²ƛƴŘƻǿǎ ǊŜǇƻǎƛǘƻǊȅΦ LŦ ǘƘŜǊŜΩǎ ƴƻ ŘǊƛǾŜǊ ƛƴ ǘƘŜ ǊŜǇƻǎƛǘƻǊȅΣ ƛǘ ǇǊƻƳǇǘǎ ǘƘŜ 

user to set a path to an additional driver repository. 

These actions guarantee a Win2K system will start up on dissimilar hardware. After the startup, Windows will initiate 

ǊŜŎƻƴŦƛƎǳǊŀǘƛƻƴ ƻŦ ŀƭƭ tƭǳƎϥƴϥtƭŀȅ ŘŜǾƛŎŜǎΦ LǘΩǎ ŀ ǎǘŀƴŘŀǊŘ ǇǊƻŎŜŘǳǊŜΣ ǎƻ ǇƭŜŀǎŜ ŘƻƴΩǘ ǿƻǊǊȅ ŀnd prepare the latest drivers 

at this step to get the most out of the system. 

 
Though all Win2K systems have built-in driver repositories, please be prepared to have 

additional drivers when dealing with Windows 2000/XP/Server 2003, because for these 
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systems they are very modest. 

Technology Application  

[ŜǘΩǎ ŎƻƴǎƛŘŜǊ ŀ ƴǳƳōŜǊ ƻŦ ǎƛǘǳŀǘƛƻƴǎ ǿƘŜƴ ǘƘŜ !ŘŀǇǘƛǾŜ wŜǎǘƻǊŜ ǘŜŎƘƴƻƭƻƎȅ Ŏŀƴ ƘŜƭǇ ȅƻǳ ƻǳǘΥ 

¶ If you need to migrate to a different hardware platform with minimal effort 

¶ If you need to upgrade hardware while keeping all programs and settings intact 

¶ If you need to replace failed hardware and cannot find an exact match for original system specifications 

Known Issues 

1. After transferring Microsoft Vista and later versions to different hardware, you will need to re-activate license of 

ǘƘŜ ǎȅǎǘŜƳΦ LǘΩǎ ƴƻǊƳŀƭ ōŜƘŀǾƛƻǊ ŀǎ ǘƘŜǎŜ ǎȅǎǘŜƳǎ ƪŜŜǇ ǘǊŀŎƪƛƴƎ ŀƴȅ ŎƘŀƴƎŜ ƻŦ ƘŀǊŘǿŀǊŜΦ wŜ-activation is legally 

justified in this case, as you transfer your system to another PC. 

2. LŦ ȅƻǳΩǾŜ ƛƴǎǘŀƭƭŜŘ ǎŜǾŜǊŀƭ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳǎ ƻƴ ƻƴŜ ǇŀǊǘƛǘƛƻƴΣ ǿŜ Ŏŀƴ ƻƴƭȅ ŀŘŘ ŘǊƛǾŜǊǎ ǘƻ ǘƘŜ ƭŀǘŜǎǘ ǾŜǊǎƛƻƴ ƻŦ 

OS. Microsoft highly recommends that you install an operating system on a separate partition. 

3. PlŜŀǎŜ ƴƻǘŜ ŘǊƛǾŜǊǎ ŀǊŜ ƴƻǘ ŎŀŎƘŜŘ ŘǳǊƛƴƎ ǎŜƭŜŎǘƛƻƴΦ ¢ƘŀǘΩǎ ǿƘȅ ƛŦ ȅƻǳ ǎŜƭŜŎǘ ŀ ŘǊƛǾŜǊ ǘƻ ŀŘŘ ǘƻ ǘƘŜ ǎȅǎǘŜƳΣ ōǳǘ 

ƛǘΩǎ ŀƭǊŜŀŘȅ ǳƴŀǾŀƛƭŀōƭŜ ŘǳǊƛƴƎ ǘƘŜ ƻǇŜǊŀǘƛƻƴΣ ǘƘŜ ǇǊƻƎǊŀƳ ǿƛƭƭ ŜƴŘ ǘƘŜ ƻǇŜǊŀǘƛƻƴ ǿƛǘƘ ŀƴ ŜǊǊƻǊΦ 
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Windows Components  
In the given section you can find all the information necessary to successfully work with the Windows version of the 

product. 

Interface Overview  
This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being 

made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are 

accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program 

can be tackled by reading this very chapter. 

General Layout  

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and 

dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration. 

¢ƘŜ [ŀǳƴŎƘŜǊΩǎ window can be conditionally subdivided into several sections that differ in their purpose and 

functionality: 

 

1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  
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4. Common Tasks Bar  

5. Explorer Bar  

6. Partition List 

7. Properties Bar 

8. Disk Map  

9. Legend Bar 

10. Status Bar 

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them 

to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout. 

Main Menu  

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below: 

MENU ITEM FUNCTIONALITY 

Tools 

6ÉÅ× ,ÏÇÓȣ View logs on the carried out operations 

Send Log Files Compress and send the log to the Paragon Support Team 

&ÉÌÅ 4ÒÁÎÓÆÅÒ 7ÉÚÁÒÄȣ Transfer data from any media 

Settings... Edit the general settings of the program  

Exit  Exit the program 

Changes 

Undo `the last virtual 

operation`  

Cancel the last virtual operation on the List of Pending Operations 

Redo `the last virtual 

operation`  

Cancel the last undo virtual operation on the List of Pending Operations 

6ÉÅ× #ÈÁÎÇÅÓȣ Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info  Refresh the current information about disks 

Wizards  
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#ÒÅÁÔÅ 0ÁÒÔÉÔÉÏÎȣ Create a partition of any file system 

&ÏÒÍÁÔ 0ÁÒÔÉÔÉÏÎȣ Format a partition of any file system 

$ÅÌÅÔÅ 0ÁÒÔÉÔÉÏÎȣ Delete a partition of any file system 

5ÎÄÅÌÅÔÅ 0ÁÒÔÉÔÉÏÎÓȣ Recover an accidentally deleted partition 

-ÅÒÇÅ 0ÁÒÔÉÔÉÏÎÓȣ Merge adjacent partitions of NTFS, FAT or FAT32 file systems 

Redistribute Free 3ÐÁÃÅȣ Redistribute available disk space of existed partitions 

0ς0 !ÄÊÕÓÔ /3ȣ Make your system bootable on different hardware; recover the startup ability 

after unsuccessful migration with a 3rd party tool 

#ÒÅÁÔÅ 6ÉÒÔÕÁÌ $ÉÓËȣ Create an empty virtual disk or with specific data of one of the supported 

virtualization vendors 

0ς6 #ÏÐÙȣ Migrate a live Win2K+ physical system to a virtual environment 

0ς6 2ÅÓÔÏÒÅȣ Restore a Win2K+ physical system from a ParagonΩǎ ōŀŎƪǳǇ ŘƛǊŜŎǘƭȅ to a virtual 

environment 

P2V Adjust OSȣ Make Windows Vista/7 backups bootable on virtual hardware; recover the 

startup ability after unsuccessful virtualization with a 3rd party tool 

#ÏÐÙ (ÁÒÄ $ÉÓËȣ Create a hard disk copy 

#ÏÐÙ 0ÁÒÔÉÔÉÏÎȣ Create a partition copy 

Hard Disk 

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

#ÈÁÎÇÅ 0ÒÉÍÁÒÙ 3ÌÏÔÓȣ Modify the primary partitions enumeration for the selected hard disk 

%ÄÉÔȾ6ÉÅ× 3ÅÃÔÏÒÓȣ View/edit sectors of the selected hard disk 

Connect a Virtual Disk  /ƻƴƴŜŎǘ ŀ ǾƛǊǘǳŀƭ Řƛǎƪ ǘƻ ǿƻǊƪ ǿƛǘƘ ƛǘ ŀǎ ƛŦ ƛǘΩǎ ŀ ǇƘȅǎƛŎŀƭ Řƛǎƪ 

Disconnect a Virtual Disk  Disconnect a virtual disk 

0ÒÏÐÅÒÔÉÅÓȣ Get in-depth information on the properties of selected hard disk 

Partition  

CrÅÁÔÅ 0ÁÒÔÉÔÉÏÎȣ Create a partition 

&ÏÒÍÁÔ 0ÁÒÔÉÔÉÏÎȣ Format a partition 

$ÅÌÅÔÅ 0ÁÒÔÉÔÉÏÎȣ Delete a partition 

-ÏÖÅȾ2ÅÓÉÚÅȣ Move/Resize the selected partition 
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#ÏÎÖÅÒÔ &ÉÌÅ 3ÙÓÔÅÍȣ Convert file system of the selected partition 

!ÓÓÉÇÎ $ÒÉÖÅ ,ÅÔÔÅÒȣ Assign drive letter to the selected partition 

2ÅÍÏÖÅ $ÒÉÖÅ ,ÅÔÔÅÒȣ Remove drive letter for the selected partition 

(ÉÄÅ 0ÁÒÔÉÔÉÏÎȣ Make the selected partition unavailable for the operating system 

5ÎÈÉÄÅ 0ÁÒÔÉÔÉÏÎȣ Make the selected partition available for the operating system 

Mark Partition as Active  Make the selected partition bootable by default 

Mark Partition as Inactive  Make the selected partition non-bootable by default 

#ÈÁÎÇÅ #ÌÕÓÔÅÒ 3ÉÚÅȣ Change cluster size of the selected partition 

#ÈÁÎÇÅ 6ÏÌÕÍÅ ,ÁÂÅÌȣ Change volume label of the selected partition 

#ÈÁÎÇÅ 3ÅÒÉÁÌ .ÕÍÂÅÒȣ Change serial number of the selected partition 

#ÈÁÎÇÅ 0ÁÒÔÉÔÉÏÎ )$ȣ Change identifier of the selected partition 

Downgrade NTFS versioÎȣ Decrease version of the selected NTFS partition 

#ÈÁÎÇÅ 3)$ȣ Change SID (Security Identifier) value of any found Windows installation 

-ÁËÅ 0ÁÒÔÉÔÉÏÎ 0ÒÉÍÁÒÙȣ Make the selected partition Primary 

-ÁËÅ 0ÁÒÔÉÔÉÏÎ ,ÏÇÉÃÁÌȣ Make the selected partition Logical 

$ÅÆÒÁÇÍÅÎÔ 0ÁÒÔÉÔÉÏÎȣ Defragment data on the selected FAT or NTFS partition 

$ÅÆÒÁÇÍÅÎÔ -&4ȣ Defragment MFT (Master File Table) of the selected NTFS partition 

#ÏÍÐÁÃÔ -&4ȣ Shrink MFT (Master File Table) of the selected NTFS partition 

4ÅÓÔ 3ÕÒÆÁÃÅȣ Test surface of the selected partition/block of free space 

Check File System 

)ÎÔÅÇÒÉÔÙȣ 

Check the selected partition for possible file system errors 

%ÄÉÔȾ6ÉÅ× 3ÅÃÔÏÒÓȣ View/edit sectors of the selected partition 

0ÒÏÐÅÒÔÉÅÓȣ Get in-depth information on the properties of selected partition 

View 

Layouts Manage the Launcher layout with several predefined profiles 

Toolbar  Manage the Tool Bar representation: show / hide standard and navigation 

buttons, text labels and large icons 

Status Bar Display the Status Bar 
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Common Tasks Bar Display the Common Tasks Bar 

Disk Map Legend Display the Disk Map legend 

Properties and Commands  Display the Explorer Bar 

Disk Map Location  Select whether the Disk Map will be located on the top of the main window or 

at the bottom 

Help 

Help Open the Help system (you can also do it by pressing F1) 

About  Open the dialog with information about the program 

 

 

The Main Menu contents available at the moment may vary depending on the selected 

object. 

Tool Bar  

The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 

 

Connect a virtual disk 

 

Open the Help system 

Virtual Operations Bar  

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called 

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations 

immediately, but places them on the List of Pending Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 

 
Cancel the last virtual operation on the List of Pending Operations 

 
Cancel the last undo virtual operation on the List of Pending 

Operations 

 
Display the List of Pending Operations 

 
Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending Operations 
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Virtual mode is an effective way of protection from any troubles, since no operations will 

be executed until clicking the Apply button for confirmation, thus giving a second chance to 

weigh all pros and cons of this or that particular operation. The program politely reminds 

the user that there are unsaved changes by showing the following window: 

 

Common Tasks Bar 

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's 

wizards. 

The bar contains several tabs named Virtualization Tasks, Copy Tasks, Tools and News and Documentation. Each of 

these contains a separate button bar which can be folded by clicking it. 

Virtualization Tasks 

 
Starting the P2V Copy Wizard to migrate a live Win2K+ physical system to a virtual 

environment. 

 
Starting the P2V Restore Wizard to restore a Win2K+ physical system from a 

tŀǊŀƎƻƴΩǎ ōŀŎƪǳǇ ǘƻ ŀ ǾƛǊǘǳŀƭ ŜƴǾƛǊƻƴƳŜƴǘ. 

 
Starting the P2V Adjust OS Wizard to recover the startup ability after unsuccessful 

virtualization with a 3rd party tool; to make Windows Vista/7 backups bootable 

on virtual hardware. 

Copy Tasks 

 
Starting the Copy Hard Disk Wizard to copy a hard disk. 

 
Starting the Copy Partition Wizard to copy a partition. 

Tools 

 
Starting the Connect a Virtual Disk dialog to connect a virtual disk to work with it 

ŀǎ ƛŦ ƛǘΩǎ ŀ ǇƘȅǎƛŎŀƭ ŘƛǎƪΦ 

 
Starting the File Transfer Wizard to transfer data from any media. Besides it 

provides access to Paragon backups as regular folders to browse through their 

contents or copy required files. 

News and Documentation 
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Launching the help system (you can also do it by pressing F1). 

 
Opening the page which contains information about the program. This page will 

be displayed in the Explorer Bar. 

Disk  Map 

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the 

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map 

Location). 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with 

rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the 

file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 

¶ Manufacturer, 

¶ Model. 

Small-sized bars display the following information about logical disks: 

¶ Serial number, 

¶ Drive letter, 

¶ Total size, 

¶ File system. 

CǳǊǘƘŜǊƳƻǊŜΣ ƛǘ ƛǎ ǇƻǎǎƛōƭŜ ǘƻ ŜǎǘƛƳŀǘŜ ǘƘŜ ǳǎŜŘ Řƛǎƪ ǎǇŀŎŜ ōȅ ƭƻƻƪƛƴƎ ŀǘ ǘƘŜ ǎƛȊŜ ƻŦ ǘƘŜ ōŀǊΩǎ ǎƘŀŘŜŘ ŀǊŜŀΦ ¢ƘŜ ǇǊƻƎǊŀƳ 

offers to choose from several types of the disk lŀȅƻǳǘ ǎŎŀƭƛƴƎΦ LǘΩǎ ŘƻƴŜ ŜǎǇŜŎƛŀƭƭȅ ǘƻ ƛƴŎǊŜŀǎŜ ǘƘŜ ǇǊƻƎǊŀƳ ǳǎŀōƛƭƛǘȅΦ CƻǊ 

ƛƴǎǘŀƴŎŜΣ ƛŦ ȅƻǳΩǾŜ Ǝƻǘ ŀ ƘƛƎƘ ŎŀǇŀŎƛǘȅ ƘŀǊŘ ŘǊƛǾŜ ŎƻƴǘŀƛƴƛƴƎ ōƻǘƘ ǾŜǊȅ ƭŀǊƎŜ όƳƻǊŜ ǘƘŀƴ млл D.ύ ŀƴŘ ǊŀǘƘŜǊ ǎƳŀƭƭ όƭŜǎǎ 

than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the 

ƭƛƴŜŀǊ ǘȅǇŜύ ȅƻǳ ǿƻƴΩǘ ōŜ ŀōƭŜ ǘƻ ǎŜŜ ǎƳŀƭƭ ǇŀǊǘƛǘƛƻƴǎ ŀǘ ŀƭƭΣ ōǳǘ ǘƘƛƴƎ ǎǘǊƛǇǎΦ hƴ ǘƘŜ ƻǘƘŜǊ ƘŀƴŘΣ ƛŦ ǘƘŜ ǇǊƻǇƻǊǘƛƻƴŀƭ Řƛǎƪ 

layout is critical for you, the linear type is exactly what you need.  

NevŜǊǘƘŜƭŜǎǎ ǘƘŜǊŜΩǎ ŀ ŎƻƳǇǊƻƳƛǎŜ ǎƻƭǳǘƛƻƴ ς linear scaling with the minimal limit to small partitions. So if a partition is 

too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 



24 

/ƻǇȅǊƛƎƘǘϭ мффп-2010 Paragon Software Group. All rights reserved. 

 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will 

automatically display detailed information on it. 

 

The drag-and-drop functionality is not available when the logarithmic type of the disk 

layout is selected. 

Explorer Bar  

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays 

reference information including: 

¶ The help system; 

¶ General information on the product including its name, version and a list of helpful links; 

¶ Detailed information about disks selected on the Disk Map; 

¶ Volume Explorer utility; 

¶ Disk Editor utility. 

According to these categories the Explorer Bar has several tabs: 

¶ Disk View, which offers the user the following options: 

- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions; 

- Disk Editor to view/edit sectors of the selected partition/hard disk; 

- Volume Explorer to browse and export contents of the selected partition/hard disk; 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form. 

 

You can switch between these components by clicking tabs on the left side of the Explorer 

Bar. 

¶ Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the 

company's website to look through important technical notes or download the latest updates without having to close 

the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get additional information. 

To easily navigate through browsed pages, the program provides the following functionality: 
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BUTTON FUNCTIONALITY 

 
Return to the previously browsed page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the current page 

 

Partition List  

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system 

hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the 

possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed 

information on all hard disks/partitions found in the system including the following properties: 

   - Name, 

   - Volume label (if exists), 

   - Partition type (Primary/Extended /Logical), 

   - File system type, 

   - Size, 

   - Amount of used and unused (free) space, 

   - Start/End cylinder, 

   - Start/End head, 

   - Start/End sector 

   - Free size in sectors/bytes 

   - Active/Inactive attribute 

   - Hidden/Unhidden attribute 

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel. 
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By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change 

its order by pressing the Move up or Move down buttons. 

LŦ ȅƻǳ ŘƻƴΩǘ ƴŜŜŘ ǘƘŜ 5ƛǎƪ aŀǇΣ ǇƭŜŀǎŜ click the shown below icon to disable it: 

 

Properties Bar  

The Properties Bar provides information on the selected at the moment partition/hard disk: 

For a hard disk 

¶ Model, 

¶ Serial number, 

¶ Type of hard disk (basic or dynamic), 

¶ Total size (in GB), 

¶ Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

For a partition 

¶ Drive letter assigned to the disk, 
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¶ Volume label (if available), 

¶ Type of the logical disk, 

¶ File system (represented by the color of the graph and the selected bar), 

¶ Total size, used space and free space (in GB or MB). 

Besides you can modify practically any partition property by clicking on the required value. 

Legend Bar 

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with 

the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the 

Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32, 

   - NTFS, 

   - Linux Ext2/3/4, 

   - Linux ReiserFS, 

   - Apple HFS. 

Status Bar 

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 

Settings Overview  
The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, 

which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By 

selecting a section from the list, you can open a set of options. 


  

To get a detailed description to any setting, control, or field of the program just click the 

hint button and then the object you need. 
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General Options  

 

This section contains a set of general options that will be taken into account during any operation carried out with the 

program: 

¶ Enable data loss protection. Mark the checkbox to make the program work in the fail-safe mode (also referred 

to as the data-loss protection mode), which ensures reliability for operations by maintaining a special journal. In 

case of a hardware malfunction, power outage or an OS failure happened in the middle of a data-sensitive 

operation (resize, move, merge, redistribute, change cluster size, etc.), the program will ask to insert the 

bootable recovery media and automatically complete the interrupted operation, thus reviving the corrupted 

partition. 

 
It is strongly recommended to enable this option. 




















































































